Table of Contents

Overview ................................................................................................................ 4
Prerequisites........................................................................................................... 4
Install and Launch TestWiz Scan .............................................................................. 4
  Install TestWiz Scan .......................................................................................... 4
  Launch TestWiz Scan ....................................................................................... 5
  Identify the Scanner ............................................................................................ 5
Scan the Answer Documents ................................................................................... 7
  View the Scanned Data........................................................................................ 7
  Correct the Scanned Information ........................................................................ 10
  Manage the Test Administration Files ................................................................ 11
  Troubleshooting ................................................................................................ 12
Upload the Scanned Data........................................................................................... 12
Related Documents ................................................................................................ 13
Overview
Plain paper scanning is one way you can load test data into TestWiz. TestWiz Scan is a special add-on application to TestWiz that enables you to scan and score locally developed assessments. Students’ assessment responses are entered on plain paper answer documents and are scanned with a plain paper scanner. The materials are inexpensive. The process is simple. And results of the assessments are available immediately, online, through TestWiz.

Prerequisites
There are prerequisites required before actual test processing can begin. In place must be the following:

- **Answer documents** that are filled out and were printed on white paper from TestWiz based on the test and student information in your TestWiz database. Students should bubble in answers using a #2 pencil. Teachers should fill in the bubbles for open response items.
  
  For instructions on printing out answer sheets, refer to the online document titled, *Administering Paper/Pencil Tests: Printing Answer Sheets and Test Booklets*.

- **An installed plain paper scanner**. Make sure you have a scanner installed properly with all its necessary drivers. The scanner should be connected directly to your PC.

- **Microsoft Windows 7 or Microsoft Windows 8**. Scanning is performed through an application called TestWiz Scan. This application is supported under Microsoft Windows 7 and 8.

Install and Launch TestWiz Scan
The actual scanning of answer sheets is performed by an add-on application to TestWiz called *TestWiz Scan*. This application needs to be installed on your PC, and an image scanner must be connected directly to that PC.

**Install TestWiz Scan**
You should only need to install *TestWiz Scan* once. Other updates will automatically be installed for you if they are available. To install *TestWiz Scan* the very first time:

1. Log into TestWiz at [https://www.testwiz.net](https://www.testwiz.net) and click **Utilities** from the top menu bar.

2. From the **Test Management** menu in the Utilities Console, choose **Install TestWiz Scan – First Time**.
3. The TestWiz Scan home install page opens.

4. The installation program for TestWiz Scan requires the Microsoft applications called Windows Installer 3.1 and .Net Framework 3.5 SP1. A dialog box may appear asking if you want to save or run the file. Click Run. The TestWiz Scan Setup dialog appears.

5. Click Accept and continue with the installation process, which can take up to one hour.

6. Once you have the required applications installed, click the launch link to start the TestWiz Scan installation.

**Launch TestWiz Scan**

Once the installation for TestWiz Scan is complete, you may start TestWiz Scan at any time. To do so:

1. Click on the Start menu and select All Programs. Choose Certica Solutions followed by TestWiz Scan.

2. When the login dialog appears, enter the User Name and Password that you use to log into TestWiz.

   **Note:** You must log in using an account that has permission to perform scanning. If you encounter any difficulties logging in, please call 877-456-8949 and provide your User Name and email address.

3. Click Login.

**Identify the Scanner**

The first time you log into TestWiz Scan, you may see an error message indicating that there is no scanner selected. Click OK and the Scanning dialog opens to the Scanner Settings tab.
Proceed to select the scanner you are using:

1. Select the scanner that you are using from the Scanner drop-down menu.
2. You may edit the other selections or leave them as they are. They are there only for troubleshooting purposes.
   - **Warn On Missing Answers** - If any answers are missing during scanning, you will see a message.
   - **Warn On Multiple Marks** - You will hear a beep if any items have more than one response.
   - **Show Percentage** - After scanning, you see percentages indicating how much of the bubbled answer was scanned.
   - **Ignore Missing Pages** - If you are not scanning all the pages for a test, this option lets you bypass error messages that indicate pages are missing.
   - **Mark Detection Threshold** - Degree to which marks are detected as answers.
   - **Image Quality** - Quality of the scanned image.
   - **Scan Resolution** - Amount of clarity for the scanned image.
   - Click **Debug** mode to have the option to send messages to TestWiz Client Services for assistance.
   - Click **Reset to Defaults** if you want to use the settings used when the scanner was first installed.
3. Click **Apply** to use these settings or **Cancel** to close the dialog box without changing anything.

If you need to change the scanner later, you can open this dialog box by choosing **Scanner Options** from the **Options** menu.
**Note:** The **Scanner Capabilities** tab shows the options that your scanner has available and is only useful for troubleshooting. There is nothing to do on this tab.

---

### Scan the Answer Documents

Once a scanner is selected, you may start scanning in tests. To do so:

1. Put the filled-out answer sheets into the hopper of the scanner. Make sure you put the correct side facing up, depending on your scanner. The location of the bar code on the answer sheets does not matter – it can be up or down.

2. Click the **Scan** option on the top menu of TestWiz Scan.

![TestWiz Scan](image)

The papers are automatically fed into the scanner and scanned. As each test is scanned, the student names appear in the upper right portion of the screen. The first scanned sheet will take longer to process as TestWiz decodes the test that you are processing.

You may start working with the data, even while more tests are being scanned in.

### View the Scanned Data

Once any test documents are scanned, you may start working with the scanned data. You can edit the responses, delete student records, and upload to TestWiz.

### The Workspace

The workspace is divided into four sections:

- **Top left, “Test records to Be Scored”:** This area shows the tests administrations that have been scanned, but not yet uploaded to TestWiz. Notice that you can be scanning more than one test at a time. Notice that there is a Students Completed column that tells you how many complete test administration documents have been scanned.

- **Top right:** This shows one record per student with that student’s responses on multiple choice items and scores on open response items. If the test has multiple pages, they will all be combined into one row for each student. Although not something you would do regularly, you can change a student’s response and score here. In particular, this gives you the opportunity to fix responses that were erroneously missed by the scanner or read in as multiple marks.

- **Bottom right:** This area shows the actual image that was scanned. Highlight a student’s name in the
top right section and see his/her answer document. If you click on a particular response, TestWiz Scan will zoom in on that area. Or, use the magnifying glass icon to zoom in on any area in the section. If the test had more than one page, there will be the option on the bottom of the area to go to another page.

- **Bottom left, “Scored Tests”:** To send the data to TestWiz, click on the red **Upload** link. The bottom left section will report on the upload process and let you know when it is complete.

### Locate Any Issues with the Scanned Documents

To find records with problems, use the drop-down list to the left of **Find Next**.

1. Select a type of problem to look for: **multimarks** (shown as *), **invalid responses**, **missing pages**, or **skipped answers** (shown as blank/empty).

**Note on multiple marks:** When an item has more than one bubble filled in, TestWiz Scan compares the density of the marks used on the bubbles. If there is more than a 5% difference in the density of the marks, the bubble with the densest mark is determined to be the response. Otherwise, the item is determined to be a “multimark.”

2. Click **Find Next** or [Tab]. The cursor moves to the next problematic record. If you make any corrections, click **Find Next** or [Tab] to save the correction and move on to the next problem. Refer to “Edit a Record” on page 10 for information on making corrections or other edits.

If you click on the student’s score for an answer, you see a close-up image of that answer:
Change the View of the Scanned Image

To better view any image of the answer sheet, you can use the icons just above the image:

- Click this so that the cursor turns to a hand. Then click the hand on the image and drag the image around to see other parts of it.
- Use these to zoom in or out on the image. Click on a magnifying glass and then click on the image.
- Select from this drop-down menu if you want to customize the zoom.
- Click this to rotate the image.

To change the view back at any time to its original state, right-click on the image and select Reset View.

If the test you scanned has more than one page to it, you can access the various pages using the tabs at the bottom of the view area where it says Page 1, Page 2, etc.
Correct the Scanned Information

When you examine the scanned student answers, you may find anomalies that you need to correct. For example:

- If a student does not fill in a bubble for an item, the answer is scanned in as blank.
- If a student fills in more than one bubble for an item, the answer is scanned in as an *.

Edit a Record

If you see a blank or a missing answer (or find such an answer as described in “Locate Any Issues with the Scanned Documents” on page 8), you can click on that item to view the image of the answer. You may be able to tell that a bubble was filled in too lightly to be picked up by the scanner, but you see the answer. In a case such as this, you can make the correction by choosing the intended response from the drop-down menu:

Missing Names/IDs from Extra Answer Sheets: If you printed out extra generic answer sheets for students who were not in the database, those sheets have student names/IDs penciled in. Those names/IDs are visible in the bottom section where the actual scanned paper is shown, but the names/IDs are blank on the grid. Use the penciled names (or other data you have) to enter the appropriate student names into the text boxes next to their
answers. When this data is uploaded, the student names will be added to the database.

**Remove a Record**

If you want to delete a scanned record entirely, right-click on the student name and choose **Select Row** from the pop-up menu. Then right-click again and choose **Delete Selected Row**.

If you need to rescan one or more of the answer sheets, simply place them into the scanner’s hopper and click on **Scan** (top menu bar). You do not need to delete a student’s record that you are rescanning. If it is the same student and the same test, TestWiz Scan updates the record with the new data.

**Print a New Answer Sheet**

If an answer sheet is crumpled, ripped, or fails to scan for other physical reasons, you can re-print specific answer documents again. Refer to the online document titled “Printing Plain Paper Answer Documents” for directions on printing answer sheets.

**Manage the Test Administration Files**

To work with the tests you scanned in, right-click on any test listed in the **Test Records To Be Scored** area (top left):

- **Open** – opens the records for that test and displays the student rows and images on the right side of the workspace.
- **Upload** – uploads the scanned test administration to TestWiz. This performs the same as the red **Upload** link on the top menu bar.
- **Test Information** – gives you details about the test. For example:
Delete – deletes the test and the scanned records. Once deleted, they are no longer available to upload. If you delete a test administration in error, you will need to rescan the answer documents.

Export to CSV File – allows you to save the scanned data in a CSV format.

Troubleshooting
You may encounter errors while scanning your tests (or at other times). If any errors are detected, the Send Error dialog box appears. You can also choose Send Message from the File menu to open the Send Error dialog box:

The errors are listed in the text area and you may type additional text, information, or questions there. If you want to send the message to Certica Solutions for analysis:

1. Decide if you want to send the error using your account name or if you would prefer to send it anonymously. Click Anonymous under "Send as" if you want to send it without your account name.

2. Click Send to send this error to the TestWiz client services team.

A team member can analyze the error and provide you with assistance. If you don’t require assistance, click Don’t Send. You can also send email directly to TestWiz@CerticaSolutions.com.

To see all the error messages that have ever been detected, choose View Log from the File menu.

Upload the Scanned Data
Scoring and viewing reports takes place on TestWiz and the scanned data must be uploaded. You do not need to wait until all students’ documents are processed. You may upload the data at any convenient time. To upload scanned data:
1. Click on a test from the “Tests Records To Be Scored” area.
2. Click **Upload** from the top menu bar.
3. The upload process begins. When it is finished the test name appears in the Scored Tests section (bottom left) with a message indicating that the upload was complete.

<table>
<thead>
<tr>
<th>Scored Tests</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Math Grade 5 Unit 7 ...</td>
</tr>
</tbody>
</table>

To remove a test listed in the Scored Tests section, right-click on the test name and choose **Clear Record**.

The uploaded data is now available on TestWiz. All TestWiz users will be able to see the results immediately.

---

**Related Documents**

Refer to these separate documents as needed. To get to them, go to the Welcome page of TestWiz and click **Help Documents** on the left sidebar.

- **Viewing and Printing Reports** — information on creating and customizing reports.
- **Administering Paper/Pencil Tests: Printing Custom Answer Sheets and Test Booklets** — how to print answer sheets and test booklets.
- **Creating and Editing External Tests** — details on setting up external tests or managing Test Specifications.
- **Creating Item Bank Tests** — details on creating a test directly in TestWiz by choosing items from an item bank.

---

**Contact Information**

Please contact Certica Solutions for help using TestWiz.

**Toll-free Help line:** 877-456-8949  
**Alternate line:** 978-456-3464  
**Email:** TestWiz@CerticaSolutions.com  
**FAX:** 978-456-3391